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Comparing Westlaw Classic and WestlawNext
Interface • Features • Functionality WestlawNext is 
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For search assistance,
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thomsonreuters.com/
guides.

WestlawNext Quick Reference Guide

When you move from Westlaw® Classic to WestlawNext®, you won’t have to relearn research skills. And, while you’ll find similar features
and services on WestlawNext, you’ll also gain the advanced search technology of WestSearch®, a search engine designed for law that
incorporates 125 years of proprietary analysis of the law and is available only on WestlawNext. You’ll also find tools to help you organize,
manage, and share your research and mobile access when you need research on the go. 

The list below includes common Westlaw Classic tasks and features and their WestlawNext equivalents, in addition to information about
WestlawNext features you won’t find anywhere else. So, start using WestlawNext today and complete your research up to three times
faster, as studies have shown.* 

Westlaw Classic WestlawNext Description of WestlawNext Interface, Feature, or Functionality

Signing On
Westlaw password/ OnePass username WestlawNext requires a OnePass username and password. Type
Online ID and password your username and password in the text boxes at the sign-on page.

Client ID Client ID At the Welcome page, type a client identifier in the text box or click
the arrow next to the Client ID text box to choose a previously used
identifier.

Select a pricing method            Select a billing method Select a billing method at the Welcome page, unless you or your
administrator previously selected a default billing method. 

Return to last research trail Return to your recent research You can choose to return to one of your last five research events,
which are listed at the Welcome page.

Mobile Access
Not available iPad® app Access WestlawNext via your iPad.

Not available AndroidTM app Access WestlawNext via your Android device. 

Not available Mobile browsers Access WestlawNext on your smartphone or tablet. 

* Study: WestlawNext Is Faster Than Westlaw
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Westlaw Classic WestlawNext Description of WestlawNext Interface, Feature, or Functionality

Finding Documents
Find a document by citation Retrieve a document by citation Type a citation in the search box at the top of the page and click Search.

Find a statute by citation Retrieve a statute by citation You can retrieve a statute by entering the citation in the search box. No find command is necessary.
WestSearch recognizes that the text entered is a citation and returns the correct document, as opposed
to running a search. You can also retrieve a statute using a Find Template. The template provides the
text of the statute citation; simply fill in the box with the section number. 

Find a case by party name Retrieve a case by party name Type the short title of the case (e.g., kelo v. new london) or parties’ names in the search box at the top of
the page, choose a jurisdiction from the Jurisdiction selector, and click Search.

Find and print multiple Retrieve multiple documents Type up to 20 citations, separated by semicolons, in the search box at the top of the page—or copy a list 
documents by citation by citation of multiple citations separated by semicolons or hard returns and paste them in the search box—and

click Search. After the documents are retrieved, select the Select all items check box and click the 
delivery icon or click the arrow next to the icon and choose a delivery method from the menu. 

To save the documents to a folder, select the Select all items check box and click the Save to folder icon
(     ) on the toolbar. Then choose your desired folder and click Save. 

Selecting Content to Search
Databases                                     Content categories Content is organized by category. There is no need to access a database. You can type your search in the

search box at the top of the home page and click Search to automatically run a search of all core legal 
content available on WestlawNext. See page 11 for a list of all core legal content categories. 

Westlaw Directory                       Browse content You can choose specific content to search by clicking category links in the Browse section of the home
page (e.g., Cases or Secondary Sources). See Figure 1 on page 12 for a view of the home page.

Database identifiers                   Category pages Each category of content is organized on its own page. When you click a category link in the Browse
section of the home page, a corresponding tabbed search box is displayed at the top of the category
page. Type your search in this box and click Search to search all content listed on the page. 

Search for a database               Category page As you begin to type a database identifier (e.g., ca-cs) or content category (e.g., california cases) in the 
suggestions search box at the top of the page, WestlawNext will suggest a corresponding category page by asking

Looking for this? (e.g., the California State and Federal Cases page). 



Comparing Westlaw Classic and WestlawNext 3Current through July 1, 2013

Westlaw Classic WestlawNext Description of WestlawNext Interface, Feature, or Functionality

Selecting Content to Search (continued)
Scope                                            Content descriptions Short content descriptions are provided on the category pages. If available, click the information icon 

(     ) to display additional information.

Favorite Databases list Favorites Category pages you have saved as favorites are listed on the home page under Favorites. To add a page
to Favorites, click the Add to Favorites star icon (       ) at the top of a category page.

Recent Databases list                Frequently Used Items Category pages you frequently access are automatically listed on the home page under Favorites. 

Tabbed pages Content category pages To research core content for a specific jurisdiction, access the category page for a state. Type your search
in the tabbed search box at the top of the page and click Search to search all content listed on the page.
You can also select specific content on the category page to search (e.g., Cases or Forms).

To research core content for a specific practice area (e.g., Commercial Law or Tax), access the category
page for the topic. Type your search in the tabbed search box at the top of the page and click Search to
search all content listed on the page. You can also select specific content on the category page to search 
(e.g., Secondary Sources or Expert Materials).

Customizing tabbed pages Organizing favorites Favorites listed on the home page can be organized as customized content groups that include up to
100 category pages. You can then run a search of all content listed on these category pages while 
viewing the home page.

Searching for Information
Natural Language Descriptive terms Type descriptive terms that describe the legal issue you are researching, e.g., what constitutes 

retaliation against a whistleblower, in the search box at the top of the page, then choose a jurisdiction
or practice area. WestSearch, a search engine designed for law, searches the world’s most 
comprehensive and authoritative collection of legal content and incorporates 125 years of proprietary
analysis of the law and tools like key numbers, KeyCite, headnotes, notes of decisions, and exclusive 
secondary sources, to deliver relevant documents that use phrasing differently from your query. 
WestSearch identifies which documents are most relevant—using term matching, legal concepts, 
document characteristics, and search patterns—and places the most relevant documents at the top of
the list. For more information about WestSearch, see page 11.
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Westlaw Classic WestlawNext Description of WestlawNext Interface, Feature, or Functionality

Searching for Information (continued)
Terms and Connectors Terms and Connectors Type a Terms and Connectors query, e.g., burden +s proof prov!, in the search box at the top of the page.

WestSearch will retrieve documents that contain your terms in the specified relationships, with the most
relevant documents listed at the top of the result page. For more information about WestSearch, see
page 11. 

WestlawNext processes a search containing the terms and, &, or, or quotation marks, without other
Boolean syntax, as a descriptive terms search. This ensures more thorough research and means that
WestSearch will include search results with concepts related to your terms. When this happens, a link
will be displayed above the search result to allow you to modify the result by running the search as
Boolean Terms and Connectors. 

You can also direct WestlawNext to run a search using these terms as Boolean Terms and Connectors 
operators by doing any of the following: 

•  Add a proximity connector, expander, or field restriction to your search. 
•  Enter your search using the Advanced Search feature, described below. 
•  Click Preferences on the home page, click the Search tab, and choose to always run searches 

containing and, &, or, or quotation marks as Boolean Terms and Connectors. 

Advanced Search When you use the Advanced Search feature, WestlawNext uses the Boolean Terms and Connectors
search method to retrieve documents. To access the Advanced Search template, click advanced next to
the Search button. Then type your terms in the appropriate text boxes. 

Smart Tools® Suggestions WestlawNext suggests spelling corrections (e.g., Did you mean …), category pages (e.g., Looking for
this?), and documents.

Require/Exclude Terms Require/Exclude Terms To require that a term (or phrase within quotation marks) be contained in every document retrieved, add a
plus symbol (+) immediately before the term. To exclude documents that contain a term (or phrase within
quotation marks), add a minus symbol (–) immediately before the term. 

Advanced Search You can also use the Advanced Search feature to specify terms that must or must not appear in documents
in your result. 

Field searching Terms and Connectors You can add field restrictions to the Boolean Terms and Connectors query you type in the search box.

Advanced Search Selected fields are available on the Advanced Search template.

Filters You can narrow a search result by choosing a filter under Narrow in the left column of the result page. Filters
vary by document type. For example, the filters available for cases include jurisdiction, date, reported status,
topic, judge, attorney, law firm, key number, party, and docket number. 
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Searching for Information (continued)
Table of Contents Table of Contents When you browse category pages for specific statutory codes, court rules, administrative codes, texts and

treatises, and other publications, a table of contents for the publication is displayed. While viewing a 
document, you can also click Table of Contents on the document toolbar to access the table of contents.

Statutes index Statutes index To view the index for the statutes of a particular jurisdiction, click Statutes Index in the right column of the
category page for the statutes.

West Key Number Digest West Key Number System® page Click the Tools tab at the home page and click West Key Number System to access the complete topic and 
(Custom Digest) key number outline. You can also click a key number in a case law, statutory, or secondary source document

to retrieve a list of headnotes that are classified under that topic and key number. Or click Cases that cite
this headnote to retrieve a list of citing references that discuss the legal issue summarized in the headnote.

Accessing Current Awareness Information 
Alerts Alerts Click Alerts at the top of any page. Available alert types are listed in the left column. Click a tab at the top of

the page to create an alert, view alert history, or create a customized newsletter. 

Not available Practitioner Insights Click the Topics tab at the home page and then click one of the following topics to display the Practitioner 
Insights page for the topic: antitrust, bankruptcy, energy and environment, finance and banking, health law,
intellectual property, labor and employment, products liability, or securities. You can access practice area-
specific legal news and analysis, all related content on WestlawNext, alerts, and recently filed legal 
documents. Practitioner Insights pages are also available for New York and National News. Practitioner 
Insights are available exclusively on WestlawNext. 

Viewing Results 
Result list Result page The result page contains three columns (see Figure 2 on page 12): The left column lists the core content 

categories, as well as available filters. The center column lists documents in the category selected in the
left column, with KeyCite flags displayed on cases, statutes, regulations, and administrative decisions. The
right column lists a sampling of the most relevant secondary sources; briefs; and pleadings, motions, and
memoranda in your search result.

Document rank order Relevancy ranking WestlawNext ranks documents on the result page by relevancy (see page 11). To change this default 
(reverse chronological or ranking, choose an option from the Sort by drop-down list at the top of the result page; for example, 
occurrence of terms) you can choose Relevance, Date, Most Cited, or Most Used for cases. 
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Westlaw Classic WestlawNext Description of WestlawNext Interface, Feature, or Functionality

Viewing Results (continued)
Result list preferences Result page options

• Hide search terms in Click the View Detail icon (          ) at the result page to choose from three levels of detail. Details varies by 
result list document type and may include the title and citation, search terms in context, and a document summary.

ResultsPlus® for Related Documents ResultsPlus technology is integrated into WestSearch, which finds and delivers related information.
search results A sampling of the most relevant secondary sources, briefs, and trial court documents in your search result

is listed under Related Documents in the right column of the result page. 

Locate in Result Search Within Results Type a Boolean Terms and Connectors query in the Search within results text box in the left column of the 
result page and click Continue. Then click Apply Filters. Your original search terms are highlighted in yellow
in the document and the terms used to narrow your result are highlighted in purple. Note: You can browse the
documents in your search result by your original search terms, by the terms used to narrow your result, or by
both. 

Viewing Documents
Browsing by search term Previous/next term Click the Search term arrows on the document toolbar to view the portions of each document that 

contain your search terms. 

Locate in Result Search text in this document Click the Search text in this document icon (        ) on the document toolbar, type a Terms and Connectors
query in the displayed search box, and click Search. Your search terms are highlighted in green. 

Previous/next section Previous/next section Click the arrow to the right of the section symbol (§) on the document toolbar to view the next section of a
statute, regulation, or treatise. Click the arrow to the left of the section symbol to view the previous section.

Go to Star Page Go to Star Page Click Go to on the document toolbar, then type a page number in the Page # text box and click Go.

Copy with Reference Copy with Reference Select the text you want to copy, then choose Copy with Reference from the menu. Paste the copied text,
which includes its citation, into your word-processing document. Note: Standard citation format is the default;
click the arrow next to Copy with Reference to choose from 13 other available formats. 

Links tab Related information tabs The tabs at the top of a document contain related information (e.g., KeyCite® information, annotations,
and court filings). To return to the full text of the document you were originally viewing, click the 
Document tab. 

Prior versions of statutes History tab Click the History tab and choose Versions from the menu to view a list of prior versions of the statute or 
and regulations federal regulation.
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Westlaw Classic WestlawNext Description of WestlawNext Interface, Feature, or Functionality

Viewing Documents (continued)
Statute annotations Statute annotations Statute annotations, except for credits, are not part of the full-text document on WestlawNext. They are 

included on the related information tabs for the statute.

•  Notes of Decisions •  Notes of Decisions •  Click the Notes of Decisions tab to view all notes of decisions, or click a topic under Notes of Decisions
in the right column to view notes of decisions indexed under the topic. 

•  References •  References •  Click the Context and Analysis tab to view references.
•  Historical and •  Legislative History Notes •  Click the History tab and choose Legislative History Materials from the menu to view relevant 

Statutory Notes materials such as committee reports, floor testimony, and executive messages.

ResultsPlus for Related Topics ResultsPlus technology is integrated into WestSearch, which finds and delivers related information.
documents Legal issues discussed in the document being viewed are listed under Related Topics in the right column.

Where available, click a link in the right column to retrieve additional documents relevant to the issue.

Organizing and Sharing Research 
Not available Folders You can organize, manage and share your research using folders. To access folders, do one of the

following:
•  Click Folders at the top of a page and click view all in the menu to display the My Folders page. 
•  Point to Folders at the top of a page and choose a folder from the menu. 
•  Click the Project Folder icon (         ) at the top of the page to display its contents. 

To save a displayed document or snippet of text, click the Save to folder icon (      ) on the document
toolbar. Select the folder in which you want to save the document or snippet and click Save. 

To save documents in a result list, select the check boxes next to the documents you want to save and
click the Save to Folder icon. Select the folder in which you want to save the documents and click Save. 

You can access a document or snippet of text in a folder at no charge for 12 months after the first time it is
viewed in the folder. WestlawNext automatically updates the KeyCite information for the cases, statutes,
regulations, and administrative decisions in your folders, as well as in WestlawNext folders you share. 

Not available Sharing research folders To share folders within your organization or across organizations, access a folders page and click the
Share icon (       ) on the toolbar or click Options in the left column and choose Share from the drop-down
list. Then add the person or group with whom you want to share the folder.
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Checking Citations
KeyCite this citation box             KeyCite command                               Type keycite or kc followed by a citation in the search box at the top of the page (e.g., kc 118 sct 2196)

and click Search.

KeyCite links on the KeyCite tabs Click the Negative Treatment tab to view the negative direct history and negative citing references for a case. 
Links tab Click the History tab to view the direct history of a case or the full history of a statute.

Click the Citing References tab to view all citing references.
Click the Filings tab to view court documents (e.g., briefs or pleadings) that cite a case.

KeyCite status flags KeyCite status flags KeyCite flags still warn you of negative treatment; new flag descriptions tell you why. The description 
and descriptions displayed next to the KeyCite flag at the top of the document indicates the most negative treatment 

affecting a document (e.g., Reversed by Hat v. Depositors Ins. Co. 9th Cir. (Cal.), July 30, 2009). This 
document is also marked with a red “Most Negative” banner (                     ) in the Negative Direct History 
display. KeyCite flags are displayed on individual documents and next to document titles in a result list,
folder, or History display. 

A red flag indicates a case is no longer good law for at least one point of law it contains or that a statute
has been amended, repealed, superseded, held unconstitutional, or preempted.

A yellow flag indicates a case has some negative history or that a statute has been renumbered, 
proposed legislation affecting it is available, or its validity has been called into doubt by a court.

No equivalent status flag If a document has some history, the number of history documents is displayed on the History tab. Click
the History tab to view the history of the document.

No equivalent status flag If a document has citing references, the number of references is displayed on the Citing References tab.
Click the Citing References tab to view all citing references.

Depth of treatment stars Depth of treatment bar The depth of treatment bar indicates the extent to which the citing case, administrative decision, or 
brief discusses the cited case. The bar has four sections to indicate the extent to which the cited case is
discussed.

KeyCite quotation marks KeyCite quotation marks
Ò

Quotation marks in a KeyCite result indicate that the citing case, administrative decision, or brief directly 
quotes the cited case.
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Checking Citations (continued)
Direct History History Click the History tab. Direct appellate history for the case is displayed in a graphical display. The cases 
(Graphical View) (Graphical View) included in the direct history and related references are listed in the left column.

Limit KeyCite History views On the History tab, choose a view (e.g., Negative Direct History) from the View drop-down list on the 
History Display toolbar.

Citing References: Citing References filters On the Citing References tab, click a content type in the left column under View to limit the citing references
Limit KeyCite Display by content type (e.g., Cases or Secondary Sources). Depending on the content type you have  chosen, you can

further narrow your citing references by selecting a filter under Narrow in the left column (e.g., Jurisdiction,
Date, Depth of Treatment, Headnote Topics, Treatment Status, and Reported Status for cases).

Click the Citing References tab to view all citing references. 

To search for specific terms within the citing references, type a Terms and Connectors query in the Search
within results text box in the left column and click Continue. Then click Apply Filters. 

Table of authorities Under development.

Delivering Information
Note: The delivery icon displayed on the document toolbar depends on the last delivery method 
selected. If you want to use this delivery method, simply click the icon.

Quick Print Print Click the Print icon or click the arrow next to the delivery icon and choose Print from the menu.

Print Document Print Click the Print icon or click the arrow next to the delivery icon and choose Print from the menu.

E-Mail Document E-Mail Click the Email icon or click the arrow next to the delivery icon and choose Email from the menu.

Download Document Download Click the Download icon or click the arrow next to the delivery icon and choose Download from the menu.

Not available Kindle® Click the Kindle icon or click the arrow next to the delivery icon and choose Kindle from the menu.

Print/Delivery Manager Delivery queue Print and download requests are saved in the delivery queue in the lower-right corner of the page until
midnight of the current day and can be printed or downloaded at any time prior to expiration. To display
the items in the delivery queue, click the View delivery queue icon. Click an item to print or download it.

Copy with Reference Copy with Reference Select the text you want to copy, then choose Copy with Reference from the menu. Paste the copied text,
which includes its citation, into your word-processing document. Note: Standard citation format is the default;
click the arrow next to Copy with Reference to choose from 13 other a vailable formats. 
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Other Interface Items, Features, or Functionality
Help Help Click Help at the bottom of any page, then click Documentation to view comprehensive Help articles

providing assistance to WestlawNext users.

Preferences Preferences Click Preferences at the bottom of any page to set your options for billing method, default sort order in
your search result, preferred document format and other delivery options, or preferred citation format.
Once set, preferences remain in place until you manually change them.

Note: Many options (e.g., result page detail or delivery method) can be set or modified on the page they
affect. There is no need to go to a separate page to set your preferences.

Research Trail Research History Click History at the top of any page, then in the left column click one of the following links:
•  Documents to display a list of documents you have viewed during the past year
•  Searches to display a list of searches you have run during the past year
•  All History to display a list of documents viewed, searches run, and other research events, such as

KeyCite results viewed during the past year

KeyCite flags are displayed on documents in your History display. WestlawNext automatically updates
the KeyCite information for your documents. 

Subscriber Subscriber Click the Tools tab at the home page and then click Subscriber Pricing Guide to view standard hourly
and transactional pricing information for specific content categories.
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Content Organized by Categories

WestlawNext content is organized by category. Content categories are listed on tabs
in the Browse section of the home page:
•  All Content: The core legal content categories, plus dockets, news, and links to

content on Westlaw Classic (e.g., public records and directories)
•  Federal Materials: Content categories for federal jurisdictions (e.g., judicial 

circuits)
•  State Materials: Content categories for each state, the District of Columbia, 

Guam and the Northern Mariana Islands, Puerto Rico, and the Virgin Islands
•  Topics: Content categories for practice areas, such as Bankruptcy, Family Law, 

Pension and Retirement Benefits, and Tax
•  Tools: Research tools, such as the West Key Number System, Subscriber, and

links to Westlaw Classic resources not available on WestlawNext, such as Case
Evaluator, Medical Litigator®, and PeopleMap.

When you click a content category link (e.g., Illinois on the State Materials tab), 
a corresponding tabbed search box is displayed at the top of the page. Type your
search in the box to search all content listed on the page you are viewing.

Content Available on WestlawNext 

WestlawNext includes 14 core legal content categories, plus dockets; news; 
legislative history; sample agreements; directories, including Westlaw Profiler®;
and international materials. The 14 core content categories are:
•  Cases •  Briefs
•  Statutes and Court Rules •  Trial Court Documents
•  Regulations •  Expert Materials
•  Administrative Decisions and Guidance •  Jury Verdicts and Settlements
•  Trial Court Orders •  Proposed and Enacted Legislation
•  Secondary Sources •  Proposed and Adopted Regulations
•  Forms •  Arbitration Materials

If you do not specify a content category, you will automatically search all core content
for the jurisdiction you choose. 

Content Currently Available Only on Westlaw Classic

All content can be searched within or from WestlawNext. While the vast majority of
content is integrated within WestlawNext, some content from Westlaw Classic is
seamlessly displayed on or can be linked to from WestlawNext. Among the content
and tools that are available via a link to Westlaw Classic are Public Records, 
PeopleMap, Court Wire, Patents, and 50 State Survey Builder. If you have any 
questions, please contact the Reference Attorneys. 

WestSearch

WestSearch, a search engine designed for law, searches the world’s most 
comprehensive and authoritative collection of legal content. WestSearch 
incorporates 125 years of proprietary analysis of the law and tools like key 
numbers, KeyCite, headnotes, notes of decisions, and exclusive secondary sources,
to deliver relevant documents that use phrasing differently from your query. 

WestSearch identifies which documents are most relevant—using term matching,
legal concepts, and document characteristics—and places the most relevant 
documents at the top of the list. 

Simplified Searching

On WestlawNext, you can use terms that describe your issue in the search box at
the top of the page and click Search. WestSearch retrieves comprehensive results
that are ranked by relevance.

Smart Searching

To locate the best documents for your research, WestSearch employs the following
Thomson Reuters editorial enhancements and proprietary research tools, much as
an expert researcher would, but faster: 
•  Key numbers •  Annotations
•  KeyCite •  Secondary sources
•  Added search terms •  Index references 

More on Content

More on Searching for Information



Figure 1. WestlawNext home page

Figure 2. WestlawNext result page
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